
 

 
 

All information contained in these materials, including products and product specifications, represents 
information on the product at the time of publication and is subject to change by Renesas Electronics 
Corporation without notice. Please review the latest information published by Renesas Electronics 
Corporation through various means, including the Renesas Electronics Corporation website 
(http://www.renesas.com). 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RX64M Group 
 

Firmware Integration Technology (FIT) Tutorial 
For e2 studio 

Rev. 1.00 May 2014 
 

32 
RENESAS MCU 
RX Family / 64M Series 

32 

A
pplication N

ote 



 

 
 

Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the 

operation of semiconductor products and application examples. You are fully responsible for the incorporation of these 
circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for 
any losses incurred by you or third parties arising from the use of these circuits, software, or information. 

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas 
Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever 
for any damages incurred by you resulting from errors in or omissions from the information included herein. 

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property 
rights of third parties by or arising from the use of Renesas Electronics products or technical information described in 
this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other 
intellectual property rights of Renesas Electronics or others. 

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or 
in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such 
alteration, modification, copy or otherwise misappropriation of Renesas Electronics product. 

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High 
Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade, 
as indicated below. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio 
and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial 
robots etc. 
“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster 
systems; anticrime systems; and safety equipment etc. 

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a 
direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may 
cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality 
grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas 
Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable 
for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for 
which the product is not intended by Renesas Electronics. 

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas 
Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage 
range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no 
liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified 
ranges. 

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products 
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use 
conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to 
implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire 
in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including 
but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or 
any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please 
evaluate the safety of the final products or systems manufactured by you. 

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental 
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all 
applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, 
the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your 
noncompliance with applicable laws and regulations. 

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose 
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not 
use Renesas Electronics products or technology described in this document for any purpose relating to military 
applications or use by the military, including but not limited to the development of weapons of mass destruction. When 
exporting the Renesas Electronics products or technology described in this document, you should comply with the 
applicable export control laws and regulations and follow the procedures required by such laws and regulations. 

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or 
otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set 
forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as 
a result of unauthorized use of Renesas Electronics products. 

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of 
Renesas Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this 
document or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its 
majority owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(2012.4) 



 

 
 

Disclaimer 
 
By using this Renesas Starter Kit+ (RSK+), the user accepts the following terms: 
 

The RSK+ is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK+ is 
assumed by the User. The RSK+ is provided by Renesas on an “as is” basis without warranty of any kind whether 
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular 
purpose, title and non-infringement of intellectual property rights with regard to the RSK+. Renesas expressly 
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data, 
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall 
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other 
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK+, 
even if Renesas or its affiliates have been advised of the possibility of such damages.  

 
 
 
Precautions 
 
The following precautions should be observed when operating any RSK+ product: 
 

 

This Renesas Starter Kit+ is only intended for use in a laboratory environment under ambient temperature and 
humidity conditions. A safe separation distance should be used between this and any sensitive equipment. Its use 
outside the laboratory, classroom, study area or similar such area invalidates conformity with the protection 
requirements of the Electromagnetic Compatibility Directive and could lead to prosecution.  
 
The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment causes harmful interference to radio or television reception, which can be determined by turning the 
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;  

 

• ensure attached cables do not lie across the equipment  

• reorient the receiving antenna  

• increase the distance between the equipment and the receiver  

• connect the equipment into an outlet on a circuit different from that which the receiver is connected  

• power down the equipment when not in use  

• consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever 
possible shielded interface cables are used.  

 
The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the 
following measures be undertaken;  
 

• The user is advised that mobile phones should not be used within 10m of the product when in use.  

• The user is advised to take ESD precautions when handling the equipment.  
 
The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the 
regulatory standards for an end product. 



 

 
 

How to Use This Manual 

1.    Purpose and Target Readers 
 
This manual is designed to provide the user with an understanding of how to use the e2 studio IDE to create a 
working project using Renesas Firmware Integration Technology (FIT) modules. The document presents, in 
tutorial form, the steps required to create a working firmware program for the RSK+RX64M platform, starting 
from a FIT Board Support Package (BSP), adding a FIT module (Flash Library), then integrating code from the 
peripheral code generator built into e2 studio. 
 
The firmware described in this document is the RSK+ sample System_Input_Capture, which captures inputs 
from the RX64M temperature sensor, ADC and RTC and logs this data in non-volatile storage, for later 
retrieval over a serial port.  The document is written for the RSK+RX64M specifically, but the steps required to 
create and import FIT modules and code generator files into a working project are applicable across the RX 
family. 
 
The manual comprises of step-by-step instructions to generate code, but does not intend to be a complete 
guide to software development on the RSK+ platform. Further details regarding operating the RX64M 
microcontroller may be found in the Hardware Manual and within the provided sample code. 
 
Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body 
of the text, at the end of each section, and in the Usage Notes section. 

 
 
The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of 
the manual for details. 

 
The following documents apply to the RX64M Group. Make sure to refer to the latest versions of these 
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web 
site. 
 

Document Type Description Document Title Document No. 
User’s Manual Describes the technical details of the RSK+ 

hardware.  
RSK+RX64M User’s 
Manual 

R20UT2593EG 

Tutorial Provides a guide to setting up RSK+ environment, 
running sample code and debugging programs. 

RSK+RX64M 
Tutorial Manual 

R20UT2594EG 

Quick Start Guide Provides simple instructions to setup the RSK+ and 
run the first sample. 

RSK+RX64M Quick 
Start Guide 

R20UT2595EG 

Code Generator 
Tutorial 

Provides a guide to code generation and importing 
into the e2 studio IDE. 

RSK+RX64M Code 
Generator Tutorial 
Manual 

R20UT2930EG 

Schematics Full detail circuit schematics of the RSK+. RSK+RX64M 
Schematics 

R20UT2589EG 

Hardware Manual Provides technical details of the RX64M 
microcontroller. 

RX64M Group 
Hardware Manual 

R01UH0377EJ 

Application Note  Provides technical details of the FIT Flash API 
Module for RX64M. 

RX64M Group Flash 
API for RX 

R01AN0319EG 

Application Note 
(this document) 

Provides a guide to creating a project a FIT-based 
from scratch within the e2 studio IDE. 

RSK+RX64M FIT 
Tutorial Manual 

R01AN0319EG 

 
The following documents are applicable across the RX family and relate to the FIT architecture. Make sure to 
refer to the latest versions of these documents. The newest versions of the documents listed may be obtained 
from the Renesas Electronics Web site. 
 



 

 
 

Document Type Description Document Title Document No. 
Application Note Describes the technical details of the FIT Board 

Support Package for the RX family.  
RX Family Board 
Support Package 
Module Using 
Firmware Integration 
Technology 

R01AN1865EG 

Application Note Describes how to add and configure a FIT module to 
an e2 studio project. . 

RX Family Adding 
Firmware Integration 
Technology Modules 
to Projects 

R01AN1723EG 

 



 

 
 

2.    List of Abbreviations and Acronyms  
 
 

Abbreviation Full Form 
API Application Programming Interface 
BSP Board Support Package 
CMT Compare Match Timer 
CPU Central Processing Unit 
DVD Digital Versatile Disc 
E1 On-chip Debugger 
FIT Renesas Firmware Integration Technology 
IDE Integrated Development Environment 
LCD Liquid Crystal Display 
LED Light Emitting Diode 
MCU Micro-controller Unit 
NVM Non Volatile Memory 
RSK Renesas Starter Kit 
SCI Serial Communications Interface 
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1.   Overview 

1.1 Purpose 
 
This RSK+ is an evaluation tool for Renesas microcontrollers. This manual describes how use FIT modules 
and peripheral code generator modules for RX together with the e2 studio IDE to create a working project for 
the RSK+ platform. 
 

1.2 Features 
 
This RSK+ provides an evaluation of the following features: 
• Creation of a base project using the RSK+RX64M Board Support Package (BSP) FIT module. 
• Integration of the Flash library FIT module into the project. 
• Peripheral Code Generation and integration using e2 studio for RX64M. 
• Project Building with e2 studio. 
 
The RSK+ board contains all the circuitry required for microcontroller operation. 
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2.   Introduction 

This application note is designed to answer, in tutorial form, how to use FIT modules for the RX family 
together with the e2 studio IDE to create a working project for the RSK platform. The tutorials help explain the 
following: 
• Creation of an empty e2 studio project and importing and configuring the BSP for RSK+RX64M 
• Importing and configuring an additional FIT Module 
• Using the e2 studio peripheral code generator alongside FIT modules 
• Integration with custom code 
• Building the project e2 studio 

  
The project generator will create a tutorial project with tow selectable build configurations: 
•  ‘HardwareDebug’ is a project built with the debugger support included. Optimisation is set to zero. 
• ‘Release’ is a project with optimised compile options, producing code suitable for release in a product. 

 
Some of the illustrative screenshots in this document will show text in the form RXxxx.  These are general 
screenshots and are applicable across the whole RX family.  In this case, simply substitute RXxxx for RX64M  
 

These tutorials are designed to show you how to use the RSK+ and are not intended as a comprehensive introduction to 
the e2 studio debugger, compiler toolchains or the E1 emulator. Please refer to the relevant user manuals for more in-
depth information. 

 
 



RSK+RX64M  3.   Creating an Empty Project and Importing the BSP 
 

R20AN0319EG0100 Rev. 1.00  Page 10 of 41 
May 31, 2014  

3.  Creating an Empty Project and Importing the BSP 

The following tutorial steps are taken from the two FIT reference documents r01an1723eg and r01an1685eg 
contained on the RSK+ DVD.  Refer to these documents for further technical details on the BSP and FIT.  The 
RSK+ installer will have already installed the FIT modules in the correct place in the e2 studio install directory, 
so these steps have been skipped in this tutorial. 

3.1 Creating the Empty Project 
 
Start e2 studio and select a suitable location for the project workspace 
 
 
• Start e2 studio and select a 

suitable location for the project 
workspace. 

 

 
 

• In the Welcome page, click ‘Go to 
the workbench’. 

 

 
 

• Create a new C project by right-
clicking in the Project Explorer 
pave and selecting ‘New -> C 
Project’ as shown.  Alternatively, 
use the menu item ‘File -> New -> 
C Project’. 
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• Enter the project name 
‘System_Input_Capture’. In 
‘Project type:’ choose ‘Sample 
Project’. In ‘Toolchains’ choose 
‘Renesas RXC Toolchain’. Click 
‘Next’. 

 

 
 

• In the ‘Target Specific Settings’ 
dialog, select the options as 
shown in the screenshot opposite. 
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• In the ‘Code Generator Settings’ 
dialog, leave ‘Use Peripheral code 
Generator’ unchecked. 

 

 
 

• In ‘Select Additional CPU Options’ 
leave everything at default values. 
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• In the ‘Global Options Settings’ 
leave everything at default values. 

 

 
 

• In the ‘Standard Header Files’ 
dialog, select C99 for ‘Library 
Configuration’.  Untick 
‘new(EC++)’ and leave all others 
at defaults. 

• ‘new(EC++) is the library for C++ 
style heap memory and is not 
used in this project. 
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• In the next dialog, untick all check 
boxes as shown opposite.  Click 
‘Finish’ 

 

 
 

• A summary dialog will appear, 
click ‘OK’ to complete the project 
generation. 
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• In the Project Explorer pane, 
expand into the ‘src’ folder, select 
‘dbsct.c’ and ‘typedefine.h’ and 
delete them from the project. 

 

 
 

• From the ‘Project’ menu, select 
‘Properties’. Expand ‘C/C++ Build’ 
and select ‘Settings’. Under ‘Tool 
Settings’ select ‘Linker -> Section’. 

• Select the ‘PResetPRG’ section 
and click the ‘Remove Section’ 
button.  The section C1 should 
now be assigned to address 
0xFFC00000. 

• Select the ‘PIntPRG’ section and 
click the ‘Remove Section’ 

• Click on the ‘P’ section and 
change it to ‘P*’. The use of the ‘*’ 
character acts as a wildcard and 
will catch all ‘P’ sections used in 
the project. 

 

 
 

• Click ‘Apply’.  The linker sections 
should be the same as shown in 
the screenshot opposite 

• We will now setup the linker to fill 
in unused interrupt vectors with 
the address of the 
undefined_interrupt_source_isr() 
function.  
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• Under ‘Tool Settings’ select ‘Linker 
-> User’.  

• Click the ‘Add’ button (with green 
‘+’ symbol) and in the window that 
pops up enter: 

 
-vect=_undefined_interrupt_source_isr 
 
• Click ‘OK’.  In the ‘Properties’ 

dialog, click ‘OK’.  The project is 
now ready to import the BSP. 

 
 

 
 

 

3.2 Importing the BSP into the Project 
 
The two FIT modules required for this Tutorial have been installed with e2 studio. 
 
• From the ‘File’ menu, select ‘New 

-> Renesas FIT Module’.  The 
dialog opposite will be displayed. 

• In the project name pull-down 
select ‘System_Input_Capture’. 

• In the ‘Family’ pull-down select 
‘RX’. 

• In the ‘Target Board’ pull-down 
select ‘RSKRX64M’. 

• In the ‘Series’ pull-down select 
‘RX600’. 

• In the ‘Group’ pull-down select 
‘RX64M’. 
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• In the main list view select the 
‘r_bsp’ module, the ‘Finish’ button 
will then be enabled.  Verify that 
the dialog is as shown opposite. 

• Click ‘Finish’. 
 

 
 

• A ‘Project Updated’ dialog will 
appear, indicating that include 
paths and source locations have 
been updated. Click ‘OK’. 
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• The newly added paths and 
symbols will be displayed in a 
Properties dialog.  Click ‘OK’ 

 

 
 

• In the Project Explorer pane, 
expand the ‘r_bsp’ folder and 
‘board’ and ‘mcu’ folders.   

• Verify that the ‘rskrx64m’ folder 
has been added to the ‘board’ 
folder. 

• Verify that the ‘rx64m’ folder has 
been added to the ‘mcu’ folder. 
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• In the Project Explorer pane, 
double-click the ‘platform.h’ 
header file icon to open the file in 
the edit pane 

• Scroll down to the line shown 
opposite and uncomment the 
include directive for the 
RSK+RX64M board. 

 

 
 

• The FIT project folder structure 
includes an ‘r_config’ folder, 
where each FIT module’s 
configuration header file resides.  
The ‘r_bsp’ FIT module contains 
an ‘r_bsp_config_reference.h’ file 
which we will need to copy into 
the ‘r_config’ folder. 

• Copy and paste this file into the 
‘r_config’ folder as shown 
opposite. 

 

 
 

• Right-click the newly copied 
‘r_bsp_config_reference.h’ file 
and select ‘Rename..’ from the 
context menu.  Rename the 
resource to ‘r_bsp_config.h’ as 
shown opposite.  Click ‘OK’. 

• The ‘r_bsp_config.h’ file is used to 
configure the BSP as described in 
Section 3.2 of r01an1685eu.  For 
the purposes of this project, we 
will leave the file unchanged. 
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• Repeat the above steps for the 
‘r_bsp_interrupt_config_reference
.h’ file, found in the ‘r_bsp -> 
board -> rskrx64m’ folder 

• The ‘r_bsp_interrupt_config.h’ file 
is used to configure the BSP 
interrupts.  For the purposes of 
this project, we will leave the file 
unchanged. 

 

 
 

• Click the top level 
‘System_Input_Capture’ folder 
again, and then the arrow next to 
the build button (hammer icon), 
and select the ‘HardwareDebug’ 
option. 

 
• e2 studio will now build the code. 
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4.Importing the Flash Library FIT Module 

• From the ‘File’ menu, select ‘New -
> Renesas FIT Module’.  The 
dialog opposite will be displayed. 

• The dialog will be populated with 
the previous selections from §3.2. 

• In the main list view select the 
‘r_flash_api_rx’ module, the ‘Finish’ 
button will then be enabled.  Verify 
that the dialog is as shown 
opposite. 

• Click ‘Finish’. 
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• A ‘Module Information’ dialog will 
appear, indicating that the Flash 
API FIT module has a dependency 
on the BSP FIT module. Click ‘OK’. 

 

 
 

• A ‘Project Updated’ dialog will 
appear, indicating that include 
paths and source locations have 
been updated. Click ‘OK’. 
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• The newly added paths and 
symbols will be displayed in a 
Properties dialog.  Click ‘OK’ 

 

 
 

• In the Project Explorer pane, 
expand the ‘r_flash_api_rx’ folder 
and ‘ref’ and ‘src’ folders.   

• The screenshot opposite shows the 
Flash API FIT module files have 
been installed correctly. 
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• The ‘r_flash_api_rx’ FIT module 
installer has placed a 
‘r_flash_api_rx_config.h’ file in the 
‘r_config’ folder. 

 

 
 

• Double-click this file and set the 
#defines for 
FLASH_CFG_CODE_FLASH_ENA
BLE and 
FLASH_CFG_CODE_FLASH_BG
O to 0 as shown opposite.  

• Refer to r01an2072 for details of 
these configuration options. 

 

 
 

  
• Click the top level 

‘System_Input_Capture’ folder 
again, and then the arrow next to 
the build button (hammer icon), and 
select the ‘HardwareDebug’ option. 

 
• e2 studio will now build the code. 
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5.Using the Code Generator for Peripheral Functions 

The System_Input_Capture sample applications uses a number of peripheral functions of the RX64M MCU.  
The drivers for each of these peripheral functions are created by the in-built Code Generator for e2 studio.  
The Code Generator is normally used to create a stand-alone project from scratch.  Since we have created 
this project using a FIT BSP, it is necessary to exclude some of the code generator start-up files from the build 
and manually add some include paths in order to properly integrate the code generator files within the FIT 
software architecture. 
 
In this section of the Tutorial, the steps required to generate the peripheral drivers required for the sample are 
presented, together with the additional steps required to build the project. 
 
• Right-click the top level 

‘System_Input_Capture’ and select 
‘New -> Code Generator’. 

 
 

• After a few seconds, a ‘Code 
Generator’ node will appear in the 
project explorer pane. 

• Expand the ‘Code Generator -> 
Peripheral Functions’ node, and 
double-click the Compare Match 
Timer node. 

• The ‘Peripheral Functions’ tab will 
be activated in the Build Pane as 
shown opposite. 
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• Right-click the top level 
‘System_Input_Capture’ and select 
‘Import’. 

• In the dialog that appears, expand 
the ‘Code Generator’ node and 
select ‘Code Generator Setting’.  
Click ‘Next’. 

 

 
 
• The dialog shown opposite will be 

displayed. 
• The file 

‘System_Input_Capture.cgp’ is 
provided on the DVD and has been 
installed with the sample project in 
the directory 
‘System_Input_Capture’. 

• Detailed use of the Code Generator 
GUI to configure MCU peripherals 
is outside the scope of this 
document, since it is covered in the 
Code Generator Tutorial r20ut2930. 

• Locate this file and copy it into the 
local workspace for this project. 

• Browse to this file using the 
‘browse’ button, then click ‘Finish’. 

• In the warning dialog, click ‘OK’. 
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• Expand the ‘Code Generator -> 
Peripheral Functions’ node, and 
double-click the Compare Match 
Timer node again. 

• Notice how the CMT settings have 
been imported for CMT0-3. 

• Settings for the Compare Match 
Timer, Realtime Clock, Serial 
Communications Interface, I2C Bus 
Interface and 12-bit A/D Converter 
have been imported. 

 

 
 

• In the right of the Peripheral 
Functions dialog, click ‘Generate 
Code’ 

• The ‘Console’ tab in the Build Pane 
will be updated. 
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• In the Project Explorer pane, 
expand the ‘src’ folder node. 

• The System_Input_Capture.c’ file 
has been excluded from the build 
as part of the code generation 
operation. 

• All of the Code Generator files 
have been placed inside a new 
sub-folder ‘cg_src’, under the ‘src’ 
folder. 

 

 
 
 

• Right-click the greyed-out 
‘System_Input_Capture.c’ node 
and select ‘Properties’. 

• Select ‘C/C++ Build’ and untick the 
‘Exclude resource from build’, 
check box.  Click ‘OK’. 
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• Since we are using 
‘System_Input_Capture.c’ for the 
main() C function, and FIT BSP 
source files for start-up and 
interrupt handling, we need to 
exclude some code generator 
source files from the build. 

• In the Project Explorer pane, 
expand the ‘System_Input_Capture 
-> src -> cg_src’ folder node. 

• Using the CTRL key, select the 
following files with the left mouse 
button: 
r_cg_cgc_user.c 
r_cg_cgc.c 
r_cg_cgc.h 
r_cg_dbsct.c 
r_cg_hardware_setup.c 
r_cg_intprg.c 
r_cg_main.c 
r_cg_resetprg.c 
r_cg_sbrk.c 
r_cg_sbrk.h 
r_cg_stacksct.h 
r_cg_vect.h 
r_cg_vecttbl.c 

• Then right-click and select ‘Exclude 
from build…’.  The dialog opposite 
will be displayed. 

• Click the ‘Select All’ button to 
exclude the selected files from the 
build for Release and Hardware 
Debug build configurations. 

• Click OK. 
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• Verify that the files shown opposite 
are excluded from the build 
(greyed-out with a line through the 
icon). 

 
 

• In Project Explorer, locate the file 
‘iodefine.h’ as shown opposite, 
right-click and select ‘Copy’. 

• Paste the file into the 
‘System_Input_Capture -> src’ 
folder, using the right-click context 
menu or the ‘Edit – Paste’ main 
menu item. 
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• Paste the file into the 
‘System_Input_Capture -> src’ 
folder, using the right-click context 
menu or the ‘Edit – Paste’ main 
menu item. 

• This is required because the code 
generator generates the #include 
“..\iodefine.h” directive in all of its 
source files. 

 
 

• Click the top level 
‘System_Input_Capture’ folder 
again, and then the arrow next to 
the build button (hammer icon), and 
select the ‘HardwareDebug’ option. 

 
• e2 studio will now build the code. 

 

  
 
The project now contains a combined FIT/Code Generator base for adding the application code for 
System_Input_Capture.  The steps described so far are also applicable to any user application that uses a FIT 
BSP, one or more FIT modules and code generator code in combination. 
 
The steps required to complete the sample are described in the next Section.  The next part of the Tutorial is 
more specific to the System_Input_Capture application, but is also applicable for customers who wish to build 
a FIT-based application while still retaining the power and flexibility of the Renesas Code Generator. 
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6.Completing the System_Input_Capture Application 

It is not the intention of this of this document to provide a detailed walkthrough of the System_Input_Capture 
sample, not to provide a Tutorial on the use of the code generator built into e2 studio.  Therefore, rather than 
inspect detailed application code in this document, it is sufficient to simply copy source files from the 
completed System_Input_Capture sample into the user’s workspace.  This applies to both top level application 
source files as well as manual edits that have been made in the user code areas of the code generator source 
files. 
 
The reader is encouraged to inspect the application source files and the code added to the user area of the 
code generator files.  In the latter case, this is easily achieved with any diff tool. 
 
• Locate the following files in the 

completed System_Input_Capture 
sample (src folder) and copy them 
into the src folder of your 
workspace: 
 
ascii.c 
ascii.h 
r_okaya_lcd.c 
r_okaya_lcd.h 
r_rsk_data_flash.c 
r_rsk_data_flash.h 
r_rsk_iic_eeprom.c 
r_rsk_iic_eeprom.h 
r_rsk_nvm.c 
r_rsk_nvm.h 
r_rsk_switch.c 
r_rsk_switch.h 
System_Input_Capture.c 

• Locate the following files in the 
completed System_Input_Capture 
sample (src/cg_src folder)and copy 
them into the src/cg_src folder of 
your workspace: 
 
r_cg_userdefine.h 
r_cg_sci_user.c 
r_cg_sci.h 
r_cg_s12ad_user.c 
r_cg_s12ad.h 
r_cg_rtc_user.c 
r_cg_rtc.h 
r_cg_riic_user.c 
r_cg_riic.h 
r_cg_riic.c 
r_cg_icu_user.c 
r_cg_icu.h 
r_cg_icu.c 
r_cg_cmt_user.c 
r_cg_cmt.h 
r_cg_cmt.c 
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• It is necessary to edit the FIT BSP 
file hwsetup.c in order to initialise 
our code generator peripheral 
modules. 

• There are stub functions in this file 
provided for this purpose, where 
we will add our initialisation code. 

• Open the file ‘r_bsp -> board -> 
rskrx64m -> hwsetup.c’ by double-
clicking it’s node in the Project 
Explorer pane. 

• Add the following code as shown in 
the screenshot opposite.  

 
 
#include "r_cg_macrodriver.h" 
#include "r_cg_lpc.h" 
#include "r_cg_icu.h" 
#include "r_cg_port.h" 
#include "r_cg_cmt.h" 
#include "r_cg_rtc.h" 
#include "r_cg_sci.h" 
#include "r_cg_riic.h" 
#include "r_cg_s12ad.h" 
 
• Add the following code as shown in 

the screenshot opposite. 
• These API calls connect the BSP 

interrupt architecture to the code-
generator-supplied interrupt call 
back functions for the required BL0 
and BL1 interrupts.  For more 
information on the RX64M group 
interrupts refer to the hardware 
manual. 

 
 

 
    R_BSP_InterruptWrite(BSP_INT_SRC_BL0_SCI6_TEI6, (bsp_int_cb_t)r_sci6_transmitend_interrupt); 
    R_BSP_InterruptWrite(BSP_INT_SRC_BL0_SCI7_TEI7, (bsp_int_cb_t)r_sci7_transmitend_interrupt); 
    R_BSP_InterruptWrite(BSP_INT_SRC_BL0_SCI7_ERI7, (bsp_int_cb_t)r_sci7_receiveerror_interrupt); 
    R_BSP_InterruptWrite(BSP_INT_SRC_BL1_RIIC2_TEI2, (bsp_int_cb_t)r_riic2_transmitend_interrupt); 
    R_BSP_InterruptWrite(BSP_INT_SRC_BL1_RIIC2_EEI2, (bsp_int_cb_t)r_riic2_error_interrupt); 
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• Add the following code as shown in 
the screenshot opposite. 

• Is code is taken from the code-
generator-supplied 
r_cg_hardware_setup.c file and is 
necessary to initialise all of the 
code generator peripherals used in 
the project. 

• Remember to save the edits (ctrl-
s). 

 
 

 
    /* Enable writing to registers related to operating modes, LPC, CGC and software reset */ 
    SYSTEM.PRCR.WORD = 0xA50BU; 
 
    /* Enable writing to MPC pin function control registers */ 
    MPC.PWPR.BIT.B0WI = 0U; 
    MPC.PWPR.BIT.PFSWE = 1U; 
 
    /* Initialize non-existent pins */ 
    PORT5.PDR.BYTE = 0x70U; 
 
    /* Set peripheral settings */ 
    R_LPC_Create(); 
    R_ICU_Create(); 
    R_PORT_Create(); 
    R_CMT0_Create(); 
    R_CMT1_Create(); 
    R_CMT2_Create(); 
    R_CMT3_Create(); 
    R_RTC_Create(); 
    R_SCI6_Create(); 
    R_SCI7_Create(); 
    R_RIIC2_Create(); 
    R_S12AD0_Create(); 
    R_S12AD1_Create(); 
 
    /* Enable writing to registers related to operating modes, LPC, CGC and software reset */ 
    SYSTEM.PRCR.WORD = 0xA50BU; 
 
    /* Enable writing to MPC pin function control registers */ 
    MPC.PWPR.BIT.B0WI = 0U; 
    MPC.PWPR.BIT.PFSWE = 1U; 
 
    /* Initialize non-existent pins */ 
    PORT5.PDR.BYTE = 0x70U; 
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• Open the project properties from 
the ‘Project -> Properties’ menu 
item, or by selecting the project in 
the Project Explorer pane then 
clicking the  button. 

• In the ‘Properties for 
System_Input_Capture’ dialog, 
browse to ‘C/C++ Build -> Settings 
Tool Settings -> Compiler -> 
Source’ 

• Click the  button shown 
opposite with the tool-tip. 

 
 

• In the ‘Add directory path’ dialog, 
click the ‘Workspace…’ button. 

• In the ‘Folder selection’ dialog’, 
browse and select the 
‘System_Input_Capture -> src -> 
cg_src’ folder.  Click ‘OK’. 

• In the ‘Add directory path’ dialog, 
click ‘OK’. 

• Repeat the steps above to add the 
path ‘System_Input_Capture -> src’ 
to the list of Include file directories. 

• In the ‘Properties for 
System_Input_Capture’ dialog, 
click ‘Apply’. 
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• Staying the ‘Tool Settings’ tab of the 
‘Properties for 
System_Input_Capture’ dialog, 
navigate to ‘Compiler -> CPU -> 
Advanced’ 

• In ‘Other CPU options, ensure that 
‘Pack structures, unions and 
classes’ is ticked. 

• This is to ensure efficient reading, 
writing and use of NVM. 

• In the ‘Properties for 
System_Input_Capture’ dialog, 
click ‘OK’. 

 
 

 
• Click the top level 

‘System_Input_Capture’ folder 
again, and then the arrow next to 
the build button (hammer icon), and 
select the ‘HardwareDebug’ option. 

 
• e2 studio will now build the code. 

 

 
The application is now complete.  For instructions on how to run the System_Input_Capture sample refer to 
the Description.txt file contained in the completed sample.  To use the e2 studio debugger, refer to the Tutorial 
Manual r20ut2594eg. 
 
 



RSK+RX64M  7.   Additional Information 
 

R20AN0319EG0100 Rev. 1.00  Page 37 of 41 
May 31, 2014  
 

7.Additional Information 

Technical Support 
For details on how to use e2 studio, refer to 
the help file by opening e2 studio, then 
selecting Help > Help Contents from the 
menu bar. 

 

 
For information about the RX/64M series microcontrollers refer to the RX/64M Group Hardware Manual. 
 
For information about the RX assembly language, refer to the RX Series Software Manual. 
 
Technical Contact Details 
 
Please refer to the contact details listed in section 9 of the “Quick Start Guide” 
 
General information on Renesas microcontrollers can be found on the Renesas website at: 
http://www.renesas.com/ 
 
  
Trademarks 
All brand or product names used in this manual are trademarks or registered trademarks of their respective 
companies or organisations. 
 
 
Copyright 
This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of 
this document, either in whole or part is prohibited without the written permission of Renesas Electronics 
Europe Limited. 
 
© 2014 Renesas Electronics Europe Limited. All rights reserved. 
© 2014 Renesas Electronics Corporation. All rights reserved. 
© 2014 Renesas Solutions Corp. All rights reserved. 
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